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[Figures are not included in this sample chapter]

Woody Leonhard Teaches Microsoft Office 97
- 18 -
Excel Preliminaries

We’ve come a long way from the days of green eyeshades, columnar pads, pencil 
sharpeners, and mechanical pull-down-the-handle calculators. With Excel 97 you can 
make more calculation errors in a second than an experienced accountant used to be able 
to make in weeks.

That’s why I’m going to approach Excel differently here than in the other introductory 
books, videos, online help systems, and the like. They want you to think of Excel as a 
wonderfully capable upgrade of the old columnar pad, with a fast and savvy built-in 
calculator. I want you to think of Excel as a loaded shotgun aimed directly at your foot, 
with the safety off.

If you’re accustomed to looking at computer-generated spreadsheets and believing the 
numbers are correct just because "they were done on the computer; they have to be 
right," think of the following chapters as a much-needed dose of reality. Mathematical 
errors in Excel spreadsheets are almost as common as spelling errors in Word 
documents. It isn’t enough that Excel (and Word for that matter) gives you the tools to 
avoid most of the problems. You have to learn how to use the tools and then apply what 
you’ve learned religiously. Otherwise, one twitch and the Excel shotgun goes kaboom!

Welcome to Excel Boot Camp, recruit.

Heh heh heh. 

Terminology

What is the difference between a worksheet and a workbook? Is a spreadsheet the data I see on the 
screen, the stuff that prints on a page, or the computer program responsible for both? Is a printed 
spreadsheet the same as a worksheet?

GOSPEL ACCORDING TO WOODY
Throughout this book I’ll use the term spreadsheet (or occasionally sheet) to refer to a 
single grid with rows and columns and cells. 
One or more spreadsheets make a workbook. In fact, a workbook is just an .xls file, and I 
will use that term occasionally as well.

Just accept it right from the get-go. Excel terminology sucks. In fact, terminology throughout the 
spreadsheet industry (there’s that s word again!) runs all over the map. In Excel 97 if you click File, 
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then New, you’ll see a tab marked Spreadsheet Solutions. Yet if you click File, then Print, you’ll be 
given the option to print the Active sheet. If you look in the Help index, you’ll find some reference to 
sheets, a lot of reference to worksheets, but nothing at all about spreadsheets. When you create a new 
.xls file, Excel calls it Book1. Yet if you look in the Help index, you’ll find lots about workbooks, but 
the only entries about books refer to bound paper books, like the one you’re holding in your hand. 
And on and on.

OH REALLY?
OK. Yeah, I do know why Microsoft doesn’t activate AutoSave automatically. Advanced 
Excel users tend to play around with their spreadsheets quite a bit, and they use Save as a 
safety net. Instead of relying on Undo to back out of a series of mistakes, Excel users 
frequently Save when they’ve reached a steady point in a spreadsheet’s development, then 
go back and open the saved file if something major goes awry. (It’s important to note that 
Excel doesn’t have anywhere near the Undo capabilities that are embodied in Word, and 
that all Undo information disappears whenever a workbook is saved; I’ll talk about that 
more in the next chapter.)
I don’t like that approach for two reasons. First, running without AutoSave leaves you 
incredibly vulnerable to a power outage or other system screw-up: if you’ve been playing 
with a spreadsheet for a couple of hours without saving and the power goes bye-bye, 
your only option may be cyanide.
Second, Excel should be set up to help novices, right out of the box. That includes 
AutoSave. More advanced users should be able to figure out how to cycle through 
several backups using Save As. Novices’ spreadsheets shouldn’t be sacrificed for the 
convenience of advanced users, who can generally fend for themselves.

The beast that I call a spreadsheet has an official name in Microsoft-speak. It’s called a worksheet, but 
Microsoft uses the name so cavalierly, and you’ll hear worksheet used so infrequently, that I’m going 
to use the common, vulgar term.

Crucial Changes

Excel 97’s settings, straight out of the box, are certainly more than adequate if you don’t intend to use 
it very much. On the other hand, if you really want to take advantage of what the product has to offer, 
I’d strongly recommend you make these simple changes.

AutoSave

For the life of me, I have no idea why Excel 97 doesn’t install AutoSave automatically.

The very first thing you should do before you start relying on Excel 97 is to install and activate the 
AutoSave feature. Just as with Word 97, AutoSave automatically saves a copy of your open 
workbooks, at intervals you can set. Unlike Word 97, though, AutoSave is considered an add-in and 
you have to go hunting for it. Bah!

Although Microsoft’s implementation of AutoSave in Excel leaves much to be desired--for example, 
you have to specify a filename for any previously unsaved workbook, which is ludicrous--running 
with AutoSave still beats the devil out of working without a net. Get AutoSave going now.
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Enable AutoSave

1. Start Excel. (Click Start, Programs, Microsoft Excel.)

2. Click Tools, then Add-Ins. You should see the Add-Ins dialog box, as shown in Figure 
18.1.

FIGURE 18.1 The Add-Ins dialog box, where you can find AutoSave.

WHAT IF IT ISN’T THERE?
If you did something very weird when you installed Office 97, it’s possible that you don’t 
have AutoSave listed in the Add-Ins dialog box. If that’s the case, dig out your Office 97, 
and click Start, Settings, Control Panel. Double-click Add/Remove Programs, click 
Microsoft Office 97, then click Add/Remove. When you get the Microsoft Office 97 
Setup screen, click Add/Remove. At the Microsoft Office 97 Maintenance dialog box, 
click once on Excel, then click Change Options. Choose Add-Ins from the list, then 
click Change Options again. Finally, check the box marked AutoSave, then OK, and 
continue with the Add Programs options.

3. Check the box marked AutoSave, then click OK. That activates the AutoSave Add-In.

4. To set AutoSave options, click Tools, then AutoSave. You’ll see the AutoSave dialog 
box, as shown in Figure 18.2.

FIGURE 18.2 AutoSave settings become available under the Tools menu.

5. Personally, I feel comfortable having the active workbook saved every ten minutes, 
but your impressions may differ. (Just don’t set it too low, if you’re going to be using 
large workbooks--the delay from too many AutoSaves will drive you nuts.) I also don’t 
want to be asked if I want to save every time AutoSave kicks in, so I unchecked that box.

If you haven’t yet given a new Excel workbook a filename when AutoSave kicks in, you’ll have to 
type a name and put up with AutoSave’s nonsense. And I can hardly believe that Excel deletes all 
Undo information whenever a workbook is saved. Those are two of the worst design glitches in 
Office 97 today, in my opinion, and the people who are responsible for them should be banished to 
the seventh level of Excel Hell.

Even given AutoSave’s myriad problems, using it is still better than losing all your data if Excel 
crashes or locks up. And it does. Oh, yes, it does.

Stay Put After Enter

When you type in Word, the program just puts whatever you type up on the screen. Simple. But when 
you move to Excel, you have to be able to tell Excel when you’re done typing things into a cell. 
Although there are lots of ways to do that, most people simply press the Enter key.

Unfortunately, Excel 97 does strange things when you press Enter. Generally it moves the cursor 
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down to the next cell, the one directly below the one you’ve been typing in. (There are circumstances 
where pressing Enter can trigger even more bizarre behavior.) Personally, I rarely want to go down to 
the next cell when I press Enter. Mostly I just want Excel to acknowledge the fact that I’ve typed a 
number or a formula, and show the result in the spreadsheet. Sometimes I want to move on to the 
next cell--right, left, up, or down, but when that happens I’m perfectly content to use the arrow keys 
on my keyboard to specify precisely where I want to go.

If you want Excel to simply stay put after you type something into a cell and press Enter, it’s easy to 
change.

Click Tools, Options, and click the Edit tab. Remove the check mark in front of the Move selection 
after Enter box, as shown in Figure 18.3.

FIGURE 18.3 Make Excel behave normally when you enter data into a cell and press Enter.

Click OK and Excel drops one of its most irritating predispositions.

Max Out the Most Recently Used List

Excel, like Word, keeps a list of most recently used files at the bottom of the File menu. If you have a 
very tiny screen and run Excel at 640 x 480 resolution, you might want to succumb to Excel’s anemic 
default setting, showing only the four most recently used files on the list. Most of us, though, would 
like to see all that Excel can offer. In this case, the maximum number Excel will show is nine files.

Click Tools, Options, and click the General tab. Make sure the Macro virus protection box is 
checked, then run the Recently used file list spinner up to 9 (see Figure 18.4).

FIGURE 18.4 Check the Macro virus protection setting and run the MRU list up to 9 entries.

Click OK and Excel will start showing nine files on the File menu.

Add Auditing Toolbar

Get ready for the most controversial recommendation you’ll find in this book.

Excel 97 ships with one of the most sophisticated set of error-tracking tools available in any 
computer program, anywhere. For some reason, though, most people don’t know they exist, and only 
a tiny fraction of all Excel-ulites ever use them.

I say "for some reason" as if I didn’t know why the tools are never used. Fact is, I do know why. First, 
they’re buried in a weird Excel backwater and if you didn’t already know they existed, you’d never 
find them. (Try bringing up Office Bob and typing, oh, audit or check formulas.) Second, none of 
the introductory books even mention them, much less show you how to use them. Third, even if you 
did know they existed, there’s only one way (far as I know, anyway) to get to them--through an 
obscure toolbar that isn’t referenced anyplace in the menus, and only rarely in Help.

Here’s how you get at Excel’s auditing tools, the gizmos that will catch a very large percentage of all 
your mistakes--before your boss does.
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Click Tools, Customize, and click the Toolbars tab. Check the box marked Auditing. It’s way down 
on the list, but that’s the one you need. Click Close and the Auditing toolbar appears. Personally, I 
click the double vertical lines at the front of the Auditing toolbar and drag it down to the bottom of 
the screen, as shown in Figure 18.5.

I’ll show you how to use the Auditing toolbar in the beginning of Chapter 20, "Building 
Spreadsheeets." Think of it as an integral part of your Excel arsenal. Some day it’ll save your tail.

FIGURE 18.5 Bring the Auditing toolbar onto the screen and position it someplace handy.

The Screen

Let’s take a look around the Excel screen. You don’t need to get too hung up on any of this 
terminology, but you might want to mark this page and refer back to Figure 18.6 if you get bogged 
down at some future point.

FIGURE 18.6 The Excel 97 screen.

Title Bar

The Excel 97 title bar is virtually identical to Word 97’s. I talked about the Word 97 title 
bar on page 97. 

Menu Bar

Right below the title bar, Excel has a menu bar. The top-level menu items look remarkably similar to 
those in Word. We’ll have a chance to use them all in the next few chapters.

Toolbars

Excel 97 ships with two toolbars showing: the top one is called the Standard toolbar and the second 
one is known as the Formatting toolbar. Again, similarities with Word pop up all over the place.

I also had you add the Auditing toolbar, in the preceding Exercise. It’s probably sitting at the bottom 
of your screen.

Formula Bar

The Excel 97 Formula bar, on the other hand, is quite unique to Excel. On the left side you’ll see the 
Name box, which lets you navigate to different places in your spreadsheets. On the right side Excel 
has room for you to type things into cells and edit the stuff that already exists in cells.

The Spreadsheet

The major part of the Excel 97 screen is devoted to the spreadsheet, of course.
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As you’ve probably guessed already, each of those little rectangles you see is a cell. The cell is the 
atomic particle of Excel spreadsheets, the basic building block that will ultimately hold all the 
numbers and formulas.

Every Excel 97 spreadsheet is limited to 16,777,216 cells, arranged in 256 columns (which run from 
A to IV), and 65,536 rows (numbered 1 to 65536). That’s a lot of cells.

The active cell--the one that has contents currently displayed in the Formula bar--gets outlined with a 
heavy black line. In Figure 18.6, cell A1 is the active cell.

CELL NAMES
If you’re new to spreadsheets, you need to get used to the naming convention. It’s a lot 
like the naming system you’ll find in chess, or on most maps--or if you’ve ever played 
Battleship. 
Each cell in a spreadsheet has a name, called an address. The cell in the upper-left corner 
is called A1. (You can tell because it’s in the A column, and in the row marked 1.) The 
cell below it is called A2. The cell to the right of A1 is called B1. Then, working left to 
right, you’ll see C1, D1, E1, and so on. Get the picture?
When Excel runs out of letters, it doubles-up. So, for example, the cell to the right of Z1 
gets the moniker AA1, then AB1, AC1, and so on. To the right of AZ1 sits BA1, then 
BB1, then BC1.
If you’re ever in doubt, look at the Column headings and Row headings to get your 
bearings.

The horizontal and vertical scrollbars let you navigate through the spreadsheet, much as you would 
expect. Click the up or down arrows, and the spreadsheet moves up or down. Grab the thumb to slide 
around long distances. Click in the blank area on the scroll bar to move up, down, left, or right a page 
or so at a time.

Sheet Tabs and Scrollbar

Unless you tell Excel to do something differently, every time you create a new workbook you get 
three spreadsheets in that workbook. When you start Excel 97, it creates a new workbook called 
Book1. And, lo and behold, Book1 contains three spreadsheets.

Near the bottom of Figure 18.6, you’ll see three tabs, marked Sheet1, Sheet2, and Sheet3. If you click 
each of those tabs in turn, you’ll jump from the first spreadsheet (called Sheet1) to the second and 
then the third.

The Sheet scrollbars to the left of the Sheet tabs just give you a way to cycle through the tabs. 
Imagine a workbook with 20 sheets. Only a few Sheet tabs can show at once, so the Sheet scrollbars 
let you move left-to-right among the 20 Sheet tabs.

Status Bar

Down at the very bottom of Figure 18.6 you’ll find a status bar not unlike the one in Word 97. It’s 
here that you’ll see visual cues about what Excel is up to. There’s also a very neat feature called 
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AutoCalculate that uses the status bar.

We’ll play with AutoCalculate on page 437.

Zoom

More than any other Office 97 application, working effectively with Excel 97 entails a lot of moving 
back and forth. As your spreadsheets get larger and larger, navigation gets tougher. Many times life 
would be much easier if you could see your entire spreadsheet--or at least a big chunk of it--at one 
time.

That’s why Excel has a Zoom icon on the Standard toolbar. Click the icon and see what your screen 
looks like at, oh, 50%, as I have in Figure 18.7.

FIGURE 18.7 The Excel screen at 50% zoom factor.

Zoom from the Standard toolbar is OK. If you can’t live with the built-in percentages shown in Figure 
18.7, you can click once on the icon and type whatever zoom percentage you like. But Zoom really 
comes into its own with the Microsoft IntelliMouse, or competing roller mice--the ones that have a 
roller in between the two buttons. (Implementations vary. I’ve seen roller mice with the roller under 
the thumb position, and several other locations as well.)

Zoom is so important in getting around a spreadsheet that you may well want to splurge and get an 
IntelliMouse (or finally figure out how to use the one you already have).

IntelliMouse

I talked about using the IntelliMouse with Word 97 on page 140.

The roller mouse received a lukewarm endorsement in Chapter 9, "Getting Around," at least in my 
opinion, it’s of limited value if your major Office preoccupation extends no further than word 
processing. If you do a bit of spreadsheet work--particularly with fairly large spreadsheets--the nature 
of the problem changes, and the IntelliMouse becomes a reasonably cost-effective addition to your 
bag of tricks.

WHICH ROLLER MOUSE IS BEST?
Every hand is different, and for that reason I strongly recommend that you try a mouse 
before paying for it. If you can, use the mouse in some sort of real world environment, 
where you’re sitting down in front of a PC and working with applications you use every 
day.
My experience with Microsoft’s IntelliMouse has been uniformly excellent: it’s a high-
quality beast that keeps rolling and rolling and... well, you get the idea. Even my ten-
year-old son, who has a habit of destroying mice while playing intense simulation games, 
has a hard time going through an IntelliMouse.

Unless there’s a roller mouse installed on your PC, you’ll have to go out and buy one, then install it 
with the software using the manufacturer’s recommendations.
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MORE MOUSING
Microsoft has quite a few IntelliMouse capabilities buried, of all places, inside its 
(unsupported) TweakUI Windows application. TweakUI lets you modify all sorts of 
strange Windows settings; the mouse support is just a tiny piece.
You can get Windows 95 and NT versions of TweakUI from 
www.microsoft.com/windows95/ info/powertoys.htm . The Windows 98 version is 
on the Win98 CD, in the folder \tools\reskit\ powertoys; you can install it by right-
clicking tweakui.inf and choosing install.
Microsoft won’t support TweakUI--it would put quite a strain on their phone support 
system, as parts of it don’t work on every PC--but I’ve found it to be quite stable and, in 
some cases, indispensable.

Inside Excel 97, the IntelliMouse gives you three significant capabilities:

l Roll the wheel up or down and the spreadsheet moves up or down, much as it would if you 
clicked the vertical scrollbar. 

l Click the roller, then move the mouse. Excel moves the spreadsheet in sync with the mouse--
up, down, right, or left. Move the mouse farther, and the spreadsheet moves more quickly. 

l This is the feature I use most. Hold the Ctrl key down and roll the wheel. Excel responds by 
zooming in and out, from 10% to 100% zoom factor, in 15% increments. 

There are lots of little features that Microsoft threw in with the IntelliMouse, but by and large I find 
them bothersome. You can play with them by clicking Start, Settings, Control Panel, then double-
clicking the Mouse applet.

I’m not going to assume that you’re going to run out and buy yet another Microsoft product, so I won’t 
explicitly talk about the IntelliMouse in the rest of this book. Suffice it to say that any time you need 
to zoom, the IntelliMouse offers substantial benefits. 


